EPSON INKJET PRINTER
STYLUS PHOTO 960

Printer Basics
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials

Ink jet printers, digital cameras, and scanners, like photocopiers and conventional cameras, can be misused by improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using ink jet printers, digital cameras, and scanners.

Trademarks

EPSON, EPSON Stylus, EPSON Photo Stickers, Micro Piezo, and MicroWeave are registered trademarks and PRINT Image Matching is a trademark of SEIKO EPSON CORPORATION.

ColorLife, BorderFree, PhotoEnhance, and EPSON Software are trademarks, and EPSON Print Lab, EPSON PhotoCenter, EPSON Store, SoundAdvice, and EPSON Connection are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Printed on recycled paper
# Contents

**WELCOME!** ................................................................. 1
- PRINT Image Matching and Exif Print ................................ 2
  - About PRINT Image Matching ......................................... 2
  - About Exif Print ....................................................... 3
- About Your Software ..................................................... 3
- About Your Documentation .............................................. 4
- Using the EPSON Printer Information Center .......................... 5
  - Launching the Animations ............................................ 5
  - Launching the Manual ................................................ 6

**PRINTING IN WINDOWS** .................................................. 7
- Loading Paper in the Sheet Feeder ..................................... 8
- Loading Envelopes ....................................................... 9
- Basic Printing ............................................................ 10
  - Selecting the Settings You Use Most Often ......................... 12
- Customizing Your Print Settings ....................................... 13
- Selecting the Correct Paper Type ..................................... 15
- Printing Borderless Photos on Cut Sheets ............................ 16

**PRINTING ON MACINTOSH** ............................................... 19
- Loading Paper in the Sheet Feeder ..................................... 20
- Loading Envelopes ....................................................... 21
- Basic Printing on Mac OS 8.6 to 9.x ................................. 22
- Basic Printing on Mac OS X ............................................ 25
- Customizing Your Print Settings ....................................... 28
- Selecting the Correct Media Type ..................................... 30
- Printing Borderless Photos on Cut Sheets ............................ 31
# Printing on Roll Paper, CDs, DVDs, and Card Stock (33)

- Printing on Roll Paper
- Loading Roll Paper
- Installing the Roll Paper Cutter and Basket
- Adjusting the Cutting Position
- Selecting Roll Paper Settings
- Removing Your Photos and Paper

# Printing on CDs and DVDs (43)

- Cleaning the Roller
- Designing CDs and DVDs
- Inserting a CD or DVD
- Printing Your Design
- Adjusting the Print Position
- Adjusting the Print Density

# Printing on Card Stock or Matte Board (54)

# Maintaining Your Printer (57)

- Cleaning the Print Head
- Running the Head Cleaning Utility
- Examining the Nozzle Check Pattern
- Replacing an Ink Cartridge
- Checking the Ink Supply
- Purchasing Ink Cartridges
- Ink Cartridge Precautions
- Removing and Installing Ink Cartridges
- Aligning the Print Head
- Cleaning the Printer
- Transporting the Printer
INSTALLING YOUR PRINTER SOFTWARE .......................... 67
Installing Printer Software on Windows Me ............................ 67
    Installing the Printer Driver for Windows Me ...................... 67
    Installing Additional Software for Windows Me .................... 68
Installing Printer Software on Windows 2000 .......................... 69
    Installing the Printer Driver for Windows 2000 ..................... 69
    Installing Additional Software for Windows 2000 ................... 71

SOLVING PROBLEMS ............................................... 73
Printer Parts ......................................................... 74
Diagnosing Printer Problems ........................................... 75
    Running a Printer Check ........................................... 76
Problems and Solutions ................................................ 77
    Setup and Software Installation Problems ......................... 77
    Printer Problems .................................................. 78
    Quality Problems .................................................. 79
    Paper Problems .................................................... 81
    CD/DVD Printing Problems ........................................ 82
    Miscellaneous Problems ........................................... 82
Uninstalling and Reinstalling Printer Software ......................... 83
    Windows .......................................................... 83
    Macintosh OS 8.6 to 9.x .......................................... 83
    Macintosh OS X .................................................... 84
Where To Get Help .................................................... 84
    Technical Support for Other Photo Software ....................... 85

REQUIREMENTS AND NOTICES ................................. 87
Windows System Requirements ........................................ 87
Macintosh System Requirements ........................................ 87
Important Safety Instructions .......................................... 88
    Ink Cartridge Safety Instructions ................................ 89
    Automatic Roll Paper Cutter Safety Instructions ................ 89
FCC Compliance Statement .............................................. 90
Welcome!

Your EPSON Stylus® Photo 960 is like having a digital darkroom on your desk. Outstanding printouts result from these advanced features:

- EPSON’s 6-color inks let you print up to 2880 × 1440 dpi (dots per inch) with award-winning EPSON Micro Piezo® technology.
- Ultra small 2-picoliter ink droplets give you finer shadow detail, dazzling highlights, and better fill across a wider range of colors.
- EPSON quick drying photo inks produce lightfast and water-resistant prints on a variety of special papers, and separate cartridges eliminate waste.
- Roll paper feeder and automatic cutter enable continuous printing and cutting of multiple photos.
- CD printing feature lets you print customized “labels”—with your own photos, text, and artwork—directly on any printable CD.
- Straight-through paper path for printing on card stock and matte board gives you more media choices than ever before.
- Optimized photo print speeds let you quickly create borderless, frame-ready prints in a variety of popular photo sizes.
PRINT Image Matching and Exif Print

Your EPSON Stylus Photo 960 printer supports the following innovative digital image formats to give you the best photo prints possible: PRINT Image Matching,™ PRINT Image Matching II, and Exif Print.

About PRINT Image Matching

EPSON’s revolutionary PRINT Image Matching (P.I.M. and P.I.M. II) technologies let your digital camera and printer work together automatically to produce the best prints possible.

Digital camera manufacturers that support PRINT Image Matching include EPSON, Casio®, Konica®, Kyocera®, Minolta®, Olympus®, Ricoh®, Sony®, Toshiba®, Pentax®, Nikon®, and Sanyo®. Check with your camera’s manufacturer to find out if PRINT Image Matching technology is included.

With PRINT Image Matching, the digital camera manufacturer can set specific printing options for each camera model. These options include:

- contrast, sharpness, and brightness
- gamma level, color space, and color saturation
- shadow point, highlight point, and color balance

The camera saves this information in each JPEG or TIFF image file. Your printer—along with EPSON Software™ Film Factory™ or the P.I.M. Plug-in for Adobe® Photoshop®—then uses the information to ensure the most accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching technology—your EPSON Stylus Photo 960 gives great photo printing results, even for non-P.I.M. images.
**About Exif Print**

The Exif (Exchangeable Image File) Print format includes information about your digital camera settings in JPEG and TIFF files. Your printer and software can use this information to create accurate print settings. Most digital cameras store Exif Print information such as shutter speed, metering, flash, exposure settings, resolution, and lens use in the image file. Your printer and Film Factory software use the information to ensure the most accurate image reproduction.

**About Your Software**

Your printer CD-ROM includes all the software you need for printing. See the *Start Here* sheet for installation instructions.

- **Your printer driver** runs your printer and lets you control how your documents look. You can’t print without it.

  **Tip:** It’s a good idea to check EPSON’s support web site periodically for free updates to your printer driver. Visit http://support.epson.com. Download instructions are posted for your convenience.

- **Your photo software** includes these great tools:

  **EPSON Print CD** gives you easy-to-use templates for printing customized designs with photos, artwork, and text directly on any printable CD or DVD (not available for Mac OS X).

  **EPSON Software Film Factory** is a photo management program that lets you organize, beautify, and print your photos in a flash. Supports PRINT Image Matching and Exif Print.

  **P.I.M. II Plug-in for Adobe Photoshop** lets you retain PRINT Image Matching image quality when you import JPEG files from your P.I.M.-enabled digital camera. (Compatible with Photoshop 6.0, 7.0, and Photoshop Elements 1.0 and 2.0.)
Your EPSON Printer Information Center gives you quick, on-screen access to information about your printer. It includes EPSON Print Show animated tutorials on loading roll paper, using the automatic cutter, and other tasks. It also includes an on-screen Reference Guide for complete information about your printer.

EPSON PhotoCenter℠ is EPSON’s free photo-sharing web site where you can store, organize, and share your photos; print high-resolution photos; and create free online postcards. Add a link to EPSON PhotoCenter on your desktop with your software installer.

Exclusive software offers, demos, and trial versions:

Monaco Systems™ MonacoEZcolor™ lets you build ICC device profiles for accurate color between scanned, displayed, and printed images.

ASF™ Image Correction Plug-Ins include Digital ROC™, which automatically restores color and removes light casts, and Digital SHO™, which automatically reveals details hidden in the dark areas of digital images.

Bellamax Photo Enhancement Service fixes red-eye, exposure, color, and sharpness in your digital photos.

About Your Documentation

To set up your printer and install its software, see the Start Here sheet.

This book contains system requirements, important safety information, your warranty, and instructions on:

- Using the EPSON Printer Information Center
- Loading all types of paper
- Printing with Windows® or on a Macintosh®
- Maintaining the printer
- Solving basic problems
Please follow these guidelines throughout:

Warnings must be followed carefully to avoid bodily injury.

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your printer.

Tips contain hints for better printing.

For more details about your printer, see your Print Show animated tutorials and Reference Guide, as described below.

Using the EPSON Printer Information Center

Need help loading roll paper or installing the cutter? Use the EPSON Printer Information Center (EPIC) to view animated tutorials that quickly show you how. EPIC also includes an on-screen Reference Guide with additional printer details. Follow the instructions on the Start Here sheet to install the EPSON Printer Information Center, if you haven’t already.

Note: You need a browser—such as Microsoft® Internet Explorer® 4.0 or later or Netscape® Navigator® 3.0 or later—to view the manual. If you are using a different browser, the pages may not display correctly.

Launching the Animations

1. Double-click the EPSON Printer Information Center icon on your desktop.

2. Click Print Show.

3. Click a title. Use the program tools to pause a lesson, replay a step, or skip ahead.

4. Click Exit to close EPSON Print Show.
Launching the Manual

1. Double-click the **EPSON Printer Information Center** icon on your desktop.

2. Click **Reference Guide**. You see this screen:

3. Click a topic on the left to expand the table of contents.

4. Click on the topic you want to view.
   - Click right arrows ▶️ to view subtopics, then click on a topic.
   - Click down arrows ❯ to close a subtopic list.

**Note:** If you see an icon for a graphic when viewing your Reference Guide in Netscape Navigator, click the **Reload** button to load the graphic.

6. **Welcome!**
Printing in Windows

Before you start, make sure your printer is set up and its software is installed as described on the Start Here sheet.

Whenever you print, make sure you do the following:

■ **Use the right paper.**
  For the best-looking photos, most vivid colors, and greatest detail, always use genuine EPSON papers and EPSON inks.

■ **Choose the right printer settings.**
  Your printer automatically adjusts itself for each type of paper. That’s why printer settings are important. They tell your printer what kind of paper you’re using and what type of print you want. Make sure you check your printer settings every time you print.

For information about printing on roll paper or card stock, see page 33. Follow the steps in these sections to print using all types of sheet-fed paper:

■ “Loading Paper in the Sheet Feeder” on page 8
■ “Loading Envelopes” on page 9
■ “Basic Printing” on page 10
■ “Customizing Your Print Settings” on page 13
■ “Selecting the Correct Paper Type” on page 15
■ “Printing Borderless Photos on Cut Sheets” on page 16
Loading Paper in the Sheet Feeder

Follow these steps to load plain paper and many special papers in the sheet feeder:

1. Slide the left edge guide to the position for your paper size, as marked on the paper support.

2. Place your paper in the printer on the right side of the sheet feeder.

3. Adjust the left edge guide to fit snugly against the paper.

4. Open the output tray extensions.

Also follow these loading guidelines:

- Always load the short edge first, even for printing landscape-oriented documents and photos.

- Load the printable side face up. It’s usually whiter or brighter than the other side.

- Load letterhead or preprinted paper into the printer top edge first.

- Don’t load paper above the arrow marks inside the edge guides.

- Check the paper package for additional handling instructions.

- Make sure the adjust lever is set to the position.

- If ink smears on thicker paper, try printing with the lever set to the position.
Loading Envelopes

You can load up to 15 envelopes at a time, as described below.

**Tip:** For best results, press each envelope flat before loading it, or load one envelope at a time.

1. Load envelopes as shown, with the flap side down and the flap edge against the left side of the sheet feeder.

2. Depending on the size of the envelopes, raise either the upper or lower paper stopper and rest it against the stack.

3. Slide the left edge guide against the envelopes.

4. Set the adjust lever to the position.

5. Choose these print settings:
   - Plain Paper as the Type setting
   - The envelope size as the paper Size setting
   - Landscape as the Orientation setting

See page 11 for instructions.
Basic Printing

After you create a document in a software program, follow these steps to print it using the basic printer settings:

1. From the File menu, click Print. You see a Print window like this one:

   ![Print window](image1)

2. Make sure EPSON Stylus Photo 960 is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or Options button, click it. Then click Properties on the next screen.)
4. Select the following in the Properties window:

Tip: For more information about printer settings, click the Help button or right-click any item on the screen and click What’s This.

5. Select from these Quality Types:
   - **Draft**: for rough drafts with reduced print quality
   - **Text**: For text-only documents with higher text quality
   - **Text & Image**: For documents with text and images with higher quality
   - **Photo**: For photos and graphics with good quality and speed
   - **Best Photo**: For photos or graphics with high print quality

6. Select other settings as shown above. See page 15 for more information about paper types.

7. Click OK.

8. At the Print window, click OK or Print to start printing.
During printing, this window appears. You can use it to cancel, pause, or resume printing and see how much ink you have left.

Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you want, you can change the Windows default printer settings for all your programs.

1. Right-click the printer icon in the Taskbar (lower right corner) on your screen.
2. Select Printer Settings. You see the window shown on page 11.
3. Select the default settings you want for all your applications, then click OK.

You can still change the settings in your program, if necessary.
Customizing Your Print Settings

You can use advanced settings for color management, printing at higher resolutions, and selecting a variety of special effects and layouts.

1. On the Main tab, click the Advanced button in the bottom right corner of the window.

2. If you see a warning note, click Continue.

3. Select the following advanced settings as necessary:

   - Select Paper & Quality options as necessary
   - Click here to select a different print quality for your paper type
   - Select Print Options as necessary

Note: To manage color when you’re using Photoshop, see “Managing Color with Custom Profiles” in your on-screen Reference Guide.

4. Once you have finished selecting advanced settings, you can:
   - Click OK to save your settings, return to the Print window, and print.
   - Click the Basic button to return to Basic settings.
   - Click the Page Layout tab and continue with step 5 to select layout settings.

Tip: You can save custom settings as a group so you can reuse them whenever you print a similar project. For more information on advanced settings, click the Help button.
5. Select the following page layout settings as necessary:

- Select image position options here
- Select image resizing options here; these affect only your printed image
- Add a watermark to printed page here
- Select multi-page document options here and here
- To print a large image on several sheets to make a poster, select settings here

6. Click OK to save your settings, then click OK or Print.
## Selecting the Correct Paper Type

Select the correct paper Type setting so your printer knows what kind of paper you’re using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this paper Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain paper</td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Panoramic Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper (including roll paper)</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper (including roll paper)</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper (including roll paper)</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper (including roll paper)</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper (including roll paper)</td>
<td></td>
</tr>
</tbody>
</table>
Printing Borderless Photos on Cut Sheets

You can print your photos with no margins, extending the image all the way to the edges of the page.

**Note:** For instructions on printing borderless photos on roll paper, see page 34.

Although borderless printing is a bit slower, you get beautiful snapshots and enlargements, without trimming, on these papers and sizes:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Photo Paper</td>
<td>4 × 6</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>4 × 6</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>4 × 6</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>5 × 7</td>
<td></td>
</tr>
</tbody>
</table>

With proper care, photographs from your EPSON Stylus Photo printer will last for many years. The special EPSON inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored.

**Tip:** For best results, always use EPSON papers.

As with traditional photos, proper care will minimize color changes and lengthen display life:

- For display, EPSON recommends that prints be framed under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, and high levels of ozone.
- As with all photographs, keep your prints away from direct sunlight.
- For proper storage, EPSON recommends that you keep prints in a photo album or plastic photo storage box in acid free, archival sleeves commonly available from most camera stores.

**Note:** Always keep unused paper in the original package.
To order EPSON paper, contact your dealer or call the EPSON Store™ at (800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

First load your paper as shown, then follow the steps below.

- Always load the short edge first, even for printing landscape-oriented photos.
- Load the printable side face up. It’s usually whiter or brighter than the other side.
- Load premium papers one sheet at a time.
- Check the paper package for additional handling instructions.

Follow these steps to print borderless photos:

1. Start your photo program and open your photo.
2. Open the File menu and click Print. Then click Properties or Preferences.
3. Select Photo or Best Photo as the Quality Type setting.

4. Choose Sheet as the Source setting.

5. Select one of the following paper types:
   - Photo Paper
   - Glossy Photo Paper
   - Premium Glossy Photo Paper

6. Click the Borderless checkbox. Read the message and click OK.

7. Select your paper Size setting.

8. Select Portrait or Landscape as the orientation setting.

9. Click OK, then click OK or Print.
Printing on Macintosh

Before you start, make sure your printer is set up and its software is installed as described on the Start Here sheet.

Whenever you print, make sure you do the following:

- **Use the right paper.**
  For the best-looking photos, most vivid colors, and greatest detail, always use genuine EPSON papers and EPSON inks.

- **Choose the right printer settings.**
  Your printer automatically adjusts itself for each type of paper. That’s why printer settings are important. They tell your printer what kind of paper you’re using and what type of print you want. Make sure you check your printer settings every time you print.

For information about printing on roll paper, see page 34. Follow the steps in these sections to print using all types of sheet-fed paper:

- “Loading Paper in the Sheet Feeder” on page 20
- “Loading Envelopes” on page 21
- “Basic Printing on Mac OS 8.6 to 9.x” on page 22
- “Basic Printing on Mac OS X” on page 25
- “Customizing Your Print Settings” on page 28
- “Selecting the Correct Media Type” on page 30
- “Printing Borderless Photos on Cut Sheets” on page 31
Loading Paper in the Sheet Feeder

Follow these steps to load plain paper and many special papers in the sheet feeder:

1. Slide the left edge guide to the position for your paper size, as marked on the paper support.

2. Place your paper in the printer on the right side of the sheet feeder.

3. Adjust the left edge guide to fit snugly against the paper.

4. Open the output tray extensions.

Also follow these loading guidelines:

- Always load the short edge first, even for printing landscape-oriented documents and photos.
- Load the printable side face up. It’s usually whiter or brighter than the other side.
- Load letterhead or preprinted paper into the printer top edge first.
- Don’t load paper above the arrow marks inside the edge guides.
- Check the paper package for additional handling instructions.
- Make sure the adjust lever is set to the position.
- If ink smears on thicker paper, try printing with the lever set to the position.
Loading Envelopes

You can load up to 15 envelopes at a time, as described below.

**Tip:** For best results, press each envelope flat before loading it, or load one envelope at a time.

1. Load envelopes as shown, with the flap side down and the flap edge against the left side of the sheet feeder.

2. Depending on the size of the envelopes, raise either the upper or lower paper stopper and rest it against the stack.

3. Slide the left edge guide against the envelopes.

4. Set the adjust lever to the position.

5. Choose these print settings:
   - **Plain Paper** as the Media Type
   - **Black** as the Ink setting
   - The envelope size as the Paper Size
   - **Landscape** as the Orientation

See page 22 (Macintosh OS 8.6 to 9.x), or page 25 (Macintosh OS X) for instructions.
Basic Printing on Mac OS 8.6 to 9.x

Before you begin, make sure you selected your printer in the Chooser as described on the Start Here sheet.

1. From the File menu, select Page Setup. You see a window like this one:

![Page Setup window](image)

- Make sure you see SP 960
- Select your paper size
- Select your paper source
- Select your document or image orientation

2. Select the correct Paper Source, Paper Size, Orientation, and other settings. Then click OK.

(For roll paper printing steps, see page 39. For double-sided printing instructions, see your on-screen Reference Guide.)

3. From the File menu, select Print. You see a window like this one:

![Print window](image)

- Select the type of paper you’re using
- Select Color or Black Ink
- Select Automatic mode
- Select higher quality or faster printing
4. Select the following settings:
   - Choose your paper from the **Media Type** list. See the table on page 30 for details.
   - Select **Color** to print a color document or black and white photograph. To print a black text document, click **Black**.
   - Choose **Automatic** to get good printing results for most projects.
   - Set the slider to **Quality** to select high-quality printing, or **Speed** for faster printing. (The slider is not available for all paper types.)

5. You can also:
   - Click **Reduced or Enlarged** to reduce or enlarge your printed image, print multiple layouts, or add a watermark.
   - Click **Background Printing** to control background printing.
   - Click **Preview** to preview your printout.
   - Click **Ink Levels** to check your ink levels.
   
   **Tip:** For more information about printer settings, click the **Settings** button.

6. Click **Print**.
7. If you turned on background printing, you can select EPSON Monitor3 from the Application menu in the upper right corner of the screen. You see the EPSON Monitor3 window:

Select your print job, then click here to cancel printing

Click to check ink levels

Click here to show or hide the print settings

Note: If you’re not using background printing and you need to cancel printing, hold down the ⌘ key and press the . (period) key.
Basic Printing on Mac OS X

If you’re using an OS X compatible printing application, follow the steps below to print a document. (If you’re using an application that’s compatible only with Macintosh Classic mode, follow the steps on page 22 instead.)

Before you begin, make sure you add your printer to the Print Center, as described on the Start Here sheet.

1. From the File menu, select Page Setup. You see a screen like this:

![Page Setup Screen]

2. Select SP 960 from the Format for menu.

3. Select the Paper Size, Orientation, and any other settings you want to use and click OK.

4. Select Print from the File menu. You see a screen like this:

![Print Screen]
5. Select **Print Settings** from the pull-down menu. You see settings like these:

![Print Settings](image)

- Select the type of paper you’re using
- Select **Color** or **Black Ink**
- Select **Automatic mode**
- Select higher quality or faster printing (if available)

6. Select the following settings:

- Choose your paper from the **Media Type** list. See page 30 for details.
- Select **Color** to print a color document or black and white photograph. To print a black text document, click **Black**.
- Choose **Automatic mode** to get good printing results for most projects.
- Set the slider to **Quality** to select high-quality printing, or **Speed** for faster printing. (The slider is not available for all paper types.)

**Note:** For details on the other available print settings, click **Help**.
7. You can also select these options in the pull-down menu:
   ■ Copies & Pages, to select the number of copies or a page range
   ■ Layout, to select page layout options
   ■ Output Options, to save your print job as a PDF file
   ■ Color Management, to select ColorSync®, adjust the color controls, change
     the gamma setting, or turn off color adjustments by the printer software
   ■ Summary, to view a list of all your selections

8. When you’re ready to print, click Print.

9. To monitor the progress of your print job, click the Print Center icon when it
   appears in the dock on the bottom of your desktop.

   Double-click your printer to display a screen like this:

   You can monitor the progress of your print job or do one of the
   following:
   ■ Click the print job, then click Delete to delete the job
   ■ Click the print job, then click Hold to pause printing
   ■ Click a print job marked “Hold” and click Resume to resume printing

   When you’re finished, close Print Center.
Customizing Your Print Settings

You can use advanced settings for color management, printing at higher resolutions, and selecting a variety of special effects and layouts.

1. On the print settings window, click Custom, then click the Custom Settings list to open it.

   Click Custom, then choose:
   - Advanced Photo 2880 (for the best quality)
   - Economy (to save ink on plain paper)
   - ColorSync (to match printed colors with compatible device colors)

   Macintosh OS X

   Macintosh
   OS 8.6 to 9.x

   Click Custom, then choose:
   - Advanced Photo 2880 (for the best quality)
   - Economy (to save ink on plain paper)
   - ColorSync (to match printed colors with compatible device colors)

   Note: For more information on custom settings, click Help (OS X) or (OS 8.6 to 9.x).

2. If you’re finished selecting custom settings, click Print to print your document.

   To select more custom settings, go to step 3.

3. To access advanced settings, click Custom and then click Advanced Settings (OS X) or Advanced (OS 8.6 to 9.x).
4. Select these advanced settings as necessary:

**Note:** For more information on advanced settings, or instructions on saving them as a group so you can reuse them later, click Help (OS X) or (OS 8.6 to 9.x).

5. **OS 8.6 to 9.x:** Click OK to save your settings, then click Print.
   
   **OS X:** Click Print.
Selecting the Correct Media Type

Select the correct Media Type setting so your printer knows what kind of paper you’re using and adjusts the ink coverage accordingly.

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain paper</td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Photo Quality Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Panoramic Photo Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper (including roll paper)</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Stickers®</td>
<td>Photo Quality Glossy Film</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
<tr>
<td>EPSON ColorLife™ Photo Paper</td>
<td>ColorLife Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper (including roll paper)</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper (including roll paper)</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
</tbody>
</table>
Printing Borderless Photos on Cut Sheets

You can print your photos with no margins, extending the image all the way to the edges of the page.

Note: For instructions on printing borderless photos on roll paper, see page 34.

Although borderless printing is a bit slower, you get beautiful snapshots and enlargements, without trimming, on these papers and sizes:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Sizes</th>
<th>Media Type setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Photo Paper</td>
<td>4 × 6</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>4 × 6</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>4 × 6</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td></td>
<td>5 × 7</td>
<td></td>
</tr>
</tbody>
</table>

With proper care, photographs from your EPSON Stylus Photo printer will last for many years. The special EPSON inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored.

Tip: For best results, always use EPSON papers.

As with traditional photos, proper care will minimize color changes and lengthen display life:

- For display, EPSON recommends that prints be framed under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, and high levels of ozone.
- As with all photographs, keep your prints away from direct sunlight.
- For proper storage, EPSON recommends that you keep prints in a photo album or plastic photo storage box in acid free, archival sleeves commonly available from most camera stores.

Note: Always keep unused paper in the original package.
To order EPSON paper, contact your dealer or call the EPSON StoreSM at (800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Note:** Borderless printing is available in Mac OS 8.6 to 9.x or Classic Mode only.

First load your paper as shown, then follow the steps below.

- Always load the short edge first, even for printing landscape-oriented photos.
- Load the printable side face up. It’s usually whiter or brighter than the other side.
- Load premium papers one sheet at a time.

1. Start your photo program and open your photo file.
2. Open the File menu and click **Page Setup**. You see the following:
3. Select your **Paper Size**.
4. Choose **Auto Sheet Feeder** as the **Paper Source**.
5. Click the **Borderless** checkbox. Read the message and click **OK**.
6. When you have finished making page setup settings, click **OK**.
7. Click **File > Print**.
8. Select your paper type as the **Media Type** option.
9. Select **Quality** (for higher quality) or **Speed** (for faster printing) using the slider. Then click **Print**.
Printing on Roll Paper, CDs, DVDs, and Card Stock

Your EPSON Stylus Photo 960 gives you several options for specialized printing:

- You can print on roll paper and use the cutter attachment to automatically print and cut a whole series of photos.
- You can print directly on printable CDs and DVDs using your own photos, text, and artwork.
- You can use the straight-through paper path to print on heavy materials such as card stock and matte board up to 1.3 mm thick.

Follow the instructions in these sections:

- “Printing on Roll Paper” below
- “Printing on CDs and DVDs” on page 43
- “Printing on Card Stock or Matte Board” on page 54

Printing on Roll Paper

You can load the following types and sizes of roll paper:

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Roll sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premium Glossy Photo Paper</td>
<td>4 inches × 26 feet</td>
</tr>
<tr>
<td></td>
<td>8.3 inches (A4) × 32.8 feet</td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper</td>
<td>4 inches × 26 feet</td>
</tr>
<tr>
<td>Premium Luster Photo Paper</td>
<td>8.3 inches (A4) × 32.8 feet</td>
</tr>
</tbody>
</table>

**Note:** You can’t print on roll paper with Macintosh OS X applications.

Follow the steps in the next sections to load roll paper, install the cutter and basket, adjust the cutting position, and print.
Loading Roll Paper

1. Remove the tape and protective paper from the end of the roll. Then insert the holders into the roll of paper as shown.

2. Make sure the end of the paper is cut straight across, with 90° corners. If the end is cut diagonally, you may have problems feeding the paper.

3. If the paper curls at the end, fold a sheet of paper over the end and roll it backward to uncurl it.

   Avoid touching the printable surface of the roll paper.

4. Remove any paper that’s in the sheet feeder at the top of the printer. Then remove the paper support, lower the output tray, and turn on the printer.

   Note: You can load and print on roll paper with the paper support (and sheets) in place. However, you may find it easier to remove them.

5. Make sure the adjust lever is set to the position.
6. Install the roll paper holders on the printer.

   Insert the left holder into the far left slot, then insert the other holder into the appropriate slot on the right (either the 4-inch slot as shown, or the 8.3-inch slot further on the right).

7. Pull out approximately 15 inches of paper and insert it into the roll paper feeder. Then slide the edge guide snugly against the paper.

   **Caution:** Don’t load roll paper into the sheet feeder at the top of the printer.

8. Push the paper into the roll paper feeder as far as it will go (about 10 inches). Hold the paper in place for a few seconds, until the printer feeds it automatically.

9. To verify that the paper is loaded straight, open the printer cover and look into the printer.
If the paper is crooked, press the \( \Theta \) roll paper button and hold it for three seconds to back the paper all the way out.

Then turn the roll paper holder knobs to roll up the paper. Press the \( \square \) paper button to clear the paper out error. Repeat steps 7 through 9 to reload the paper.

Continue with the instructions below to install the roll paper cutter and basket.

If you don’t want to install the cutter, follow the instructions on page 39 to print on roll paper.

**Installing the Roll Paper Cutter and Basket**

1. Make sure the printer is turned off, then lower the output tray.

2. Rest the cutter on the output tray. Then press down on the cutter and push it into the printer.

3. To use the basket, move the printer to the edge of the table or desk.
4. Unhook the end of the basket. Then slide the arms around the output tray and insert the pegs into the holes on the sides of the tray.

*Caution:* Don’t install the basket if you’re printing panoramic photos; this may cause a paper jam. The basket holds 40 photos, up to 7 inches long. For longer photos, remove each one after it’s printed.

5. Hook the ends of the basket shaft over the arms. Make sure the hooks rest in the grooves.

6. Push down the cloth in the middle to form a basket to hold your cut photos.

7. Turn the printer back on.

8. Now adjust the cutting position as described on page 38.
Adjusting the Cutting Position

Before you use the automatic roll paper cutter, you need to adjust the cutting position. Make sure you have roll paper loaded before you start.

1. **Windows**: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Printer Settings. Then click the Maintenance tab.

   Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or Print. Click the Utility button.

2. Click the Printer and Option Information or Printer Information icon.

   You see a window like this:

   ![Printer and Option Information window](image)

3. Click the Auto Cutter Adjustment button. You see an adjustment screen.

4. Click Print. The printer prints and cuts a pattern like this:

   ![Printed pattern](image)

5. Place the two cut pieces together and line up the patterns. Identify the one with the most precise cut between the yellow and black boxes.

   In the example shown, you would select pattern #9.

6. Select that pattern number in the window shown here and click Finish.

7. Follow the instructions on page 39 to print and cut your photos.
Selecting Roll Paper Settings

Before you print on roll paper, make sure the paper is loaded correctly, as described on page 34. If you want to cut your photos automatically, install the automatic roll paper cutter and basket as described on page 36.

Then follow the steps in the next sections to select your roll paper settings on Windows or Macintosh.

**Note:** You can’t print on roll paper when you’re using Mac OS X applications.

**Windows**

Start by opening your photo file and resizing it as necessary. Then follow these steps:

1. Open the File menu and click Print. Then click Properties or Preferences:

2. Choose Photo or Best Photo as the Quality Type.

3. Choose Roll or Roll Paper as the Paper Source. The Roll Paper Options window pops up as shown:

4. If you installed the cutter, select one of the following Auto Cutter settings:
   - For the cleanest edge, select Normal Cut.
   - To save paper, select Paper-Saving Cut. You may see a sliver of the previous or next image on your photos.
   - To operate the cutter manually, select Manual Cut. This allows you to send multiple print jobs without cutting between jobs.

5. Select Cut Sheet Mode unless you’re printing a banner. Then click OK.

**Note:** If you’re using Film Factory with roll paper, select Roll Paper or Roll Paper (No Margins) as the Paper setting. To select cutting and other roll paper options, click Properties. Don’t change any other printer settings.
6. Click **Borderless** if you want to print borderless photos.

7. Select one of the following as the paper Type option, depending on the paper you’re using:
   - **Premium Semigloss Photo Paper**
   - **Premium Luster Photo Paper**
   - **Premium Glossy Photo Paper**

8. Select the photo size as the Size setting.

9. Click **OK**, then click **OK** or **Print**.

After your photos are printed, continue with the steps on page 41.

**Macintosh**

Start by opening your photo file and resizing it as necessary. Then follow these steps:

1. **Macintosh**: Open the File menu and click **Page Setup**:

2. Select the photo size as the **Paper Size**.

3. Choose **Roll Paper** as the Paper Source.

4. Click **Borderless** if you want to print borderless photos.

5. If you installed the cutter, select one of the following Auto Cutter settings:
   - For the cleanest edge, select **Normal Cut**.
   - To save paper, select **Paper-Saving Cut**. You may see a sliver of the previous or next image on your photos.
   - To operate the cutter manually, select **Manual Cut**. This allows you to send multiple print jobs without cutting between jobs.

   **Note**: If you’re using Film Factory with roll paper, select **Roll Paper** or **Roll Paper (No Margins)** as the Paper setting. To select cutting and other roll paper options, click **Properties**. Don’t change any other printer settings.
6. Select **Cut Sheet Mode** unless you’re printing a banner.

7. Click **OK**. Then open the File menu and click **Print**.

8. Select one of the following as the Media Type option, depending on the type of paper you’re using:
   - Premium Semigloss Photo Paper
   - Premium Luster Photo Paper
   - Premium Glossy Photo Paper

9. Select **Quality** (for higher print quality) or **Speed** (for faster printing) using the slider. Then click **Print**.

Continue with the steps in the next section to remove your photos.

### Removing Your Photos and Paper

After your photos are printed and cut, you can either send another print job or remove the roll paper from the printer.

1. When the printer stops, press and release the $\bigcirc$ roll paper button to cut and eject the last photo.
   
   If you’re not using the cutter, cut the paper on the printed line, then press and release the $\bigcirc$ roll paper button to feed the paper back into printing position.

2. When you’re finished printing on roll paper, you need to “unload it” from the printer. Press the $\bigcirc$ roll paper button and hold it for three seconds. The paper feeds backwards out of the printer.
   
   You can also set the adjust lever to the $\uparrow$ position, then turn the knobs to roll up the paper. Make sure you return the adjust lever to the $\bigcirc$ position after you remove the paper.
3. Turn the knobs to roll the rest of the paper onto the holder. Then press the 
□ paper button to turn off the red □ paper light.
4. Pull the roll paper holder out of its mounting slots and remove the roll paper from
the holder.
5. Return the unused roll to its original package.
6. To remove the basket, first lift the shaft off of the arms. Then pull out the arms
and remove the basket.

7. To remove the paper cutter, first turn off the
printer. Then press the buttons with your
thumbs and pull the cutter away from the
printer.

Store your printouts in resealable plastic bags,
photo albums, or glass-covered picture frames.
Keep both printed and unused roll paper away
from high temperatures, humidity, and direct
sunlight.
Printing on CDs and DVDs

Your printer includes a special tray that lets you print customized text, graphics, and photos directly on any printable CD or DVD. The EPSON Print CD software makes it easy to import your own photos, add text, and modify your designs with a variety of special effects. You can print on both regular 12-cm CDs and 8-cm mini CDs.


Cleaning the Roller

Before you print CDs or DVDs, it’s a good idea to clean the roller inside the printer. You can do this by feeding and ejecting several sheets of plain paper.

1. Make sure the printer is turned on and letter-size paper is loaded.
2. Press the paper button to feed the paper into the printer.
3. Press the paper button again to eject the paper.
4. Repeat steps 2 and 3 several times.

Designing CDs and DVDs

You can use EPSON Print CD to create and print a design with images, graphics, and text. You can use your own photos, or choose from a selection of photographic and abstract images included with the program.

Note: EPSON Print CD software is not available for Mac OS X.

The easiest way to create your own design is to start with an existing file, and then personalize it for your own use.

1. Start EPSON Print CD.
2. Click the Open icon or select Open from the File menu. Select Sample1.ec2 and click OK (Windows) or sample01 and click Open (Macintosh).

You see the Midnight Music CD on the workspace:

3. To change the background image, click the Background icon (Windows) or choose Background from the Insert menu (Macintosh). You see a window like the following:

4. Click Select Image (Windows) or Select Background (Macintosh).
You see the following:

5. Select one of the images included with the program, and click OK (Windows) or Open (Macintosh). (You can also click the TWAIN button to scan in an image or download one from your digital camera.)

If you want to choose one of your own images, do one of the following:

- **Windows**: Click the File tab, then click Browse to locate the folder where your images are stored and click OK. You see thumbnail images of all the files in the folder. Select your image and click OK.

- **Macintosh**: Locate the folder where your images are stored, then select the one you want and click Open.

6. If you want to modify the template or enhance your image, click Image Adjustment (Windows), or use any of the available editing features (Macintosh).

You can adjust the brightness, contrast, and gamma, or apply mosaic, blur, or special color effects.
7. To edit the text, do one of the following:

■ **Windows**: Double-click any text block on the CD image to open the text editing window. Enter your text and use the tabs to apply formatting and special effects, then click **OK**.

■ **Macintosh**: Use any of the options on the Text Settings palette. You can also use the options on the Color Settings and Object Settings palettes.

![Windows Text Settings](image1)

![Macintosh Text Settings](image2)

8. To curve a single line of text, click the text, then drag the red “handle” up or down.

9. When you’re finished, choose **Save as** from the File menu to save your file.

**Note**: To check your design, it’s a good idea to print it on a sheet of plain paper before printing on a CD or DVD. Make sure you have plain paper loaded in the printer, then follow the instructions beginning on page 50 to print.

When you’re ready to load a CD or DVD, follow the instructions in the next section.
Inserting a CD or DVD

Make sure the data, music, or video is burned on your CDs or DVDs before you print. Otherwise, dirt or scratches on the surface may cause errors when you burn the data. If you plan to print large numbers of CDs or DVDs, it’s a good idea to print a small sample, then wait a day and check the quality to make sure it is satisfactory.

If you want to check the print position or color, see the instructions for adjusting print position (page 51) and density (page 53).

Before you insert a CD or DVD, make sure the printer is turned on. Otherwise, the disc may not be positioned correctly.

Then follow these steps:

1. Push in the output tray extensions, but leave the tray open.

2. Open the printer cover and set the adjust lever to the position. The paper light begins flashing rapidly.
3. Place the front sheet feeder on the output tray and push it in until it snaps into place.

4. Place the CD or DVD on the CD tray with the white or printable side face-up. To print on a mini-CD, place the mini-CD ring on the tray first, then place the CD inside the ring.

5. Slide out the edge guide to make room for the tray.

6. Insert the tray against the right side of the feeder.
7. Push the tray all the way in, aligning the curved notch with the notch in the front sheet feeder.

8. Slide the edge guide against the edge of the tray.

9. Set the adjust lever to the position.
10. Close the printer cover and press the paper button. The tray moves into printing position.

Follow the instructions in the next section to print with EPSON Print CD.

**Printing Your Design**

After you have created your design and loaded a CD or DVD, you're ready to print.

1. Open the File menu and select **Printer Settings** (Windows) or **Page Setup** (Macintosh).

2. Make sure your EPSON Stylus Photo 960 is selected, and the Paper Source is set to Manual or Manual Feed:

3. Click **OK**.
4. Open the File menu and select Print, or click the Print button. You see the following:

![Windows Print dialog box](image)

![Macintosh Print dialog box](image)

5. Click **OK** (Windows) or **Print** (Macintosh).

   **Note:** After you print, handle the CD or DVD carefully to avoid smearing the ink. Wait at least 24 hours before playing the disc or inserting it in a drive. Keep printed discs away from moisture and direct sunlight.

When you're finished printing on CDs and DVDs, make sure you return the adjust lever to the \[ position. Then remove the front sheet feeder by pulling it straight out.

**Caution:** Don’t move the adjust lever during printing; this could damage your printer.

### Adjusting the Print Position

If your printed images and text are not centered or positioned the way you want, you may need to adjust the printing position. Use the blank cardboard check disk included with your printer, or an extra CD. You can also use these steps to check the position before you print on a CD or DVD:

1. Place the position check disk (or an extra CD) on the CD tray and insert it into the printer, as described on page 47.

2. Start Print CD.

3. Follow the instructions on page 50 to make sure your EPSON Stylus Photo 960 is selected, and the Paper Source is set to Manual or Manual Feed.

4. Select Print from the File menu, or click the Print button.
You see the following:

5. Select Print Position Confirmation (or Check) Pattern and click OK. The confirmation pattern is printed on the check disk or CD.

6. Remove the check disk or CD and measure the distance from the edge of the hole to the small cross marks (distances labeled A and B as shown). You’ll need a millimeter ruler for these measurements.

7. Open the File menu and select Adjust Print Position.

---

52 Printing on Roll Paper, CDs, DVDs, and Card Stock
8. Make sure Enter Values or Value Entry is checked, then input the A distance in the Height (Top) or Top Space box. Enter the B distance in the Width (Right) or Right Space box.

9. Click OK to save the measurements to the Print CD program.

**Adjusting the Print Density**

If ink smears on your printed CDs or DVDs, you may need to adjust the color saturation or ink density. CDs from different manufacturers may absorb ink differently, so you may need to adjust the density for each type of disc. Follow these instructions to print a color saturation check pattern, and then make adjustments as necessary.

1. Start EPSON Print CD.

2. Follow the instructions on page 50 to make sure your EPSON Stylus Photo 960 is selected, and the Paper Source is set to Manual or Manual Feed.

3. Insert a test CD or DVD for printing, as described on page 47.

4. Select Print from the File menu, or click the Print button. You see the following:

5. Select Print Density Confirmation Pattern (Windows) or Print Density Check Pattern (Macintosh), and click OK.

6. After the pattern is printed, examine the printed CD or DVD and make the Color Correction setting lighter or darker as necessary.
You can print three density patterns on one disc. Each pattern is printed in a different location.

After the first pattern is printed, adjust the setting, then repeat steps 4 through 6, selecting Second or Second Time to print the second pattern.

If you want to try a third Color Correction setting, you can repeat steps 4 through 6 again and select Third or Third Time.

7. Remove the CD or DVD and let it dry for at least 24 hours. Then check the saturation levels again.

**Note:** You can also use the Brightness and Contrast settings in Print CD to adjust color saturation. See page 45 for instructions.

---

### Printing on Card Stock or Matte Board

You can use the front sheet feeder to print on white card stock or matte board up to 1.3 mm (.051 inch or 51 mil) thick, in the following sizes: letter, legal, or A4. You can also use the front sheet feeder to print on premium papers if necessary.

Before you start, turn off the printer and remove the roll paper holder and cutter, if they’re installed (see page 41 for instructions). Then turn the printer back on. (The printer must be on to load card stock correctly.)

1. Push in the output tray extensions, but leave the tray open.
2. Open the printer cover and set the adjust lever to the position. The paper light begins flashing rapidly.

3. Place the front sheet feeder on the output tray and push it in until it snaps into place.

4. Slide out the edge guide to make room for the card stock.
5. Place a sheet of card stock against the right side of the feeder, with the side you want to print on face up.

6. Slide the card stock into the printer until the leading edge is 2 to 4 inches past the small gray rollers.

7. Set the adjust lever to the ▲ position. If print quality is not satisfactory, try setting it to the ▼ position for the next print.

   If you’re using the front sheet feeder to print on paper rather than card stock, set the adjust lever to the ▼ position.

8. Close the printer cover and press the □ paper button to feed the card stock into the printer.

   Note: If the □ paper light flashes, make sure the adjust lever is set correctly, then press the □ paper button again.

9. Before you print, make sure you select Manual or Manual Feed Slot as the paper Source in your printer software (see page 11 for Windows or page 22 for Macintosh).

   When you’re finished printing on card stock, make sure you return the adjust lever to the ▼ position. Then remove the front sheet feeder by pulling it straight out.

   Caution: Don’t move the adjust lever during printing; this could damage your printer.
Maintaining Your Printer

Follow the instructions in this chapter to keep your printer working at its best and to prepare it for moving, if necessary:

■ “Cleaning the Print Head” below
■ “Replacing an Ink Cartridge” on page 59
■ “Aligning the Print Head” on page 63
■ “Cleaning the Printer” on page 65
■ “Transporting the Printer” on page 66

For more details, view your on-screen Reference Guide. Click the EPSON Printer Information Center icon on your desktop.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are missing, you may need to clean the print head. This unclogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

This section explains how to clean the print head using the Head Cleaning utility.

You can also clean the print head by holding down the ink button on the printer for three seconds. (This only works when the red ink light is off.)

Caution: When you don’t turn on your printer for a long time, print quality can decline, so turn it on and print a few pages at least once a month to maintain good print quality.
Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the red ink light is off. (If the ink light is flashing or on, you need to replace a cartridge; see page 59 for details.)

2. Windows: Right-click the printer icon on your taskbar (in the lower right corner of your screen). Select Head Cleaning.

   Macintosh OS 8.6 to 9.x: Open the File menu and choose Page Setup or Print. Click the Utility button, then click the Head Cleaning button.

   Macintosh OS X: Open the Applications folder and select EPSON Printer Utility. Select SP 960 in the printer list, click OK, and select Head Cleaning.

3. Follow the instructions on the screen to clean the print head.

   Cleaning takes about 45 seconds. The printer makes noise and the green power light flashes.

   Caution: Never turn off the printer while the green power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.

4. When the green power light stops flashing, make sure paper is loaded in the printer, then do the following:

   Windows: Click Print nozzle check pattern. Then click Print.

   Macintosh: Click Confirmation, then click Next.

   The nozzle check pattern prints (see the next section for details).

5. If the nozzle check pattern has no gaps or white lines, click Finish.

   If the pattern has white lines, click Clean to clean the print head again.

   If you don’t see any improvement after cleaning three or four times, check the solutions beginning on page 79.

   You can also turn the printer off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.
Maintaining Your Printer

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered line should be solid, with no gaps, as shown.

If your printout looks okay, you’re done.

If you see any gaps (as shown), clean the print head again; see page 58 for instructions.

Replacing an Ink Cartridge

When the red ink light flashes, one or more ink cartridges are low on ink.

When the red ink light stays on, you need to replace the cartridge(s).

When you print, you’ll also see a message on your screen telling you which cartridge is low or empty.

When a cartridge is more than six months old, you may need to replace it if printouts don’t look their best. If the quality doesn’t improve after cleaning and aligning the print head, you can replace the cartridge even if the red ink light is off.
Checking the Ink Supply

To check your ink supply, do the following:

- Windows: Right-click the icon on the Windows taskbar. Then click the Ink Monitor icon. You see a window like this:

- Macintosh:
  OS 8.6 to 9.x: Choose File > Print, then click the ink icon.
  OS X: Choose Applications > EPSON Printer Utility > SP960 > Status Monitor.

You see a window like this:

Click a cartridge image to display information about the cartridge.

Purchasing Ink Cartridges

Use these EPSON ink cartridges within six months of installing them and before the expiration date on the package:

<table>
<thead>
<tr>
<th>Ink cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>T033120</td>
</tr>
<tr>
<td>Cyan</td>
<td>T033220</td>
</tr>
<tr>
<td>Magenta</td>
<td>T033320</td>
</tr>
<tr>
<td>Yellow</td>
<td>T033420</td>
</tr>
<tr>
<td>Light Cyan</td>
<td>T033520</td>
</tr>
<tr>
<td>Light Magenta</td>
<td>T033620</td>
</tr>
</tbody>
</table>

Caution: To ensure good results, use genuine EPSON ink cartridges and do not refill them. Other products may cause damage to your printer not covered by EPSON’s warranty.
When you need new ink cartridges, contact your dealer, or call the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Ink Cartridge Precautions**

**Warning:** Keep ink cartridges out of the reach of children.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them thoroughly with water.

**Caution:** To avoid damaging the printer, never move the print head by hand.

You cannot print if an ink cartridge is empty. Even though you have a second black cartridge, you cannot print if one is empty. Leave the empty cartridge installed in the printer until you have obtained a replacement. Otherwise the ink remaining in the print head nozzles may dry out.

**Removing and Installing Ink Cartridges**

Be sure you have a new ink cartridge before you begin. Once you start replacing a cartridge, you must complete all the steps in one session.

1. Make sure the printer is turned on (the green power light should be on, but not flashing). Then open the printer cover.

2. Press and release the ink button.

   The print head moves so that the ink out arrow points to the empty cartridge.

3. Press and release the ink button again.

   - If more than one ink cartridge is empty, the next one moves under the ink out arrow.
   - If all the empty cartridges have been identified, the print head moves to the cartridge replacement position.
4. Open the cartridge cover.

5. Press in the tab on the back end of the empty cartridge to unlock it. Then squeeze both tabs, lift the cartridge out of the printer, and dispose of it carefully.

6. Remove the new cartridge from its package.

   **Caution:** Don’t touch the green circuit board on the back of the cartridge; you may inhibit normal operation and printing.

7. Slide the new cartridge into its slot. The side with the green circuit board goes in the back of the slot.

8. Press the cartridge down until it clicks into place.

9. If you need to replace any other ink cartridges, repeat steps 5 through 8. Then close the cartridge cover.

10. Close the printer cover and press the ink button. The printer begins charging the ink delivery system.

   The lights flash and the printer makes noise. Charging takes about a minute. When it’s finished, the green power light stops flashing and stays on, and the red ink light turns off.

   **Caution:** Never turn off the printer while the green power light is flashing, unless the printer hasn’t moved or made noise for more than 5 minutes.
Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see light or dark horizontal banding, you may need to align the print head.

1. Turn on the printer.
2. Load several sheets of EPSON Photo Quality Ink Jet paper.
3. **Windows:** Right-click the printer icon on your taskbar (in the lower right corner of your screen) and select Print Head Alignment.
   
   **Macintosh OS 8.6 to 9.x:** Choose File > Page Setup or Print. Click the Utility button, then click the Print Head Alignment button.
   
   **Macintosh OS X:** Open the Applications folder and select EPSON Printer Utility. Select SP 960 in the printer list, click OK, and select Print Head Alignment.
4. Follow the instructions on the screen to print a test page. You see this window:
5. On the test page, select the pattern with the two vertical lines most precisely printed on top of each other. You may need to use a magnifying glass or loupe.

Select one pattern each for rows 1 through 4. Enter the number of the best pattern for each row in the corresponding boxes on the screen. Then click Next.

If you can't find an aligned pattern, choose the one that's closest to being aligned. Then click Realignment to print another test page and repeat this step.
After you click **Next**, you see this window:

6. Click **Print** to print the first pattern on the next test page.

7. After it prints, remove and reload the test page as shown, with pattern row #1 on the right.

8. Click **Print** again to print the second test pattern.

9. Repeat steps 7 and 8 to print the third test pattern. You see this screen:

10. On the test page, select the least grainy box in each column.

Select a box for columns 1, 2 and 3. Then enter the number of the best looking box in the corresponding boxes on the screen.
11. If box 5 is the least grainy in all the rows, click Finish.

If box 5 is the best in one or more rows, clear the checkbox in those rows. Click Realignment to repeat the process for any rows that are checked. Then repeat steps 6 through 11.

**Cleaning the Printer**

To keep your printer working at its best, you should clean it several times a year.

1. Turn off the printer, unplug the power cord, and disconnect the cable.

2. Remove all the paper, then use a soft brush to clean the sheet feeder.

3. If the outer case or the inside of the sheet feeder is dirty, clean it with a soft cloth dampened with mild detergent. Keep the printer cover closed to prevent water from getting inside.

4. If the inside of the printer accidentally gets soiled with ink, wipe it off with a damp cloth.

**Warning:** Don’t touch the gears or any other parts inside the printer.

**Caution:** Never use a hard or abrasive brush, or benzine, alcohol, or thinner for cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils inside the printer.
Transporting the Printer

If you need to ship your printer, you must remove the ink cartridges and prepare the printer for transportation in its original box or a similar one.

1. Turn on the printer, then press and release the ink button.
2. Open the printer cover, then open the cartridge cover.
3. Remove the cartridges. For each cartridge, press in the tab on the back, then squeeze both tabs and lift the cartridge out of the printer.
4. Set each cartridge down on a sheet of paper or plastic with the label on top facing upward. Pack the cartridges separately in sealable plastic bags.
5. Close the cartridge cover and press the ink button. The print head moves back to its home position.
6. Turn off the printer and unplug the power cord from the electrical outlet. Then disconnect the printer cable and power cord from the printer.
7. Remove any paper from the printer, then remove the paper support, roll paper holder, basket, and automatic roll paper cutter, if they’re installed.
8. Open the printer cover. Tape the ink cartridge holder to the printer case. Then close the printer cover. **Caution:** Be sure to remove the tape after installing the printer in its new location.
9. Close the output tray.
10. Repack the printer and its attachments in the original box using the protective materials that came with them.

Keep the printer level as you transport it.

After transporting the printer, remove the tape securing the ink cartridge holder. Re-install the ink cartridges as described on page 61.

Then test your printer. If you notice a decline in print quality, clean the print head (see page 57); if output is misaligned, align the print head (see page 63).
Installing Your Printer Software

Before installing your printer software, follow the steps on the *Start Here* sheet to set up your printer and connect it to your computer.

If you’re using Windows XP, Windows 98, or Macintosh, follow the software installation instructions on the *Start Here* sheet.

If you’re using one of the operating systems below, follow the instructions in this chapter to install your printer software:

- “Installing Printer Software on Windows Me” below
- “Installing Printer Software on Windows 2000” on page 69

### Installing Printer Software on Windows Me

Before you start, make sure your printer is set up, connected to your computer, and turned on, as described on the *Start Here* sheet. Installation takes place in several phases. Follow the instructions in the two sections below, first to install your printer driver, and then to install additional software.

### Installing the Printer Driver for Windows Me

1. Turn on your computer and wait for Windows to detect your printer connection (your screen might have different wording):

   Don’t click any buttons on the screen yet.

   **Note:** If a screen like this doesn’t appear, make sure your printer is turned on and connected.
2. Put the EPSON CD-ROM in your CD-ROM or DVD drive and click Next.

3. Continue clicking Next or Finish until setup is complete.

4. When you see the license agreement, click Agree, then continue with the instructions in the next section to finish the installation.

**Installing Additional Software for Windows Me**

After you accept the license agreement, you see the Options Menu:

1. Click Install Optional Software. You see the Optional Software menu:

2. Click the button for each program to learn more about it.

   If you want the program, click Install and follow the instructions on the screen. Then click Back to return to the menu.

3. If you see a message about installing QuickTime®, click Yes and follow the on-screen instructions. You don’t need a registration number.

4. When you’re finished installing software, close any open windows and click Back to return to the Options Menu.

5. Click View Software Offers. Click the button for each offer to learn more about it, then follow the instructions on the screen. When you’re finished, click Back to return to the Options Menu.

   If you see a message asking you to restart your computer, select No and click Finish. It’s better to restart after you have finished installing software.
6. When you’re finished, close any open windows and click **Back** to return to the Options Menu.

7. Click **Install Printer Information Center**, then follow the on-screen instructions.

8. At the Options Menu, click **Exit**.

9. When you see the registration screen, register your printer with EPSON as instructed. Remove the CD-ROM and keep it in case you need to reinstall any software later.

10. Restart your computer if prompted. You’re ready to print.

---

**Installing Printer Software on Windows 2000**

Before you start, make sure your printer is set up, connected to your computer, and turned on, as described on the *Start Here* sheet. Installation takes place in several phases. Follow the instructions in the two sections below, first to install your printer driver, and then to install additional software.

**Installing the Printer Driver for Windows 2000**

1. Turn on your computer.

2. Wait for Windows to detect your printer connection and display a screen like this:

   ![](image)

   **Don’t click any buttons on the screen yet.**

   **Note:** If this screen doesn’t appear, make sure your printer is turned on and connected.

3. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few seconds for the CD-ROM to be recognized.

4. Click **Next**.
5. Select the **Search for** option, then click **Next**.

You see a screen like this (your screen might have different wording):

6. Make sure **CD-ROM drives** is checked, then click **Next**.

7. At the next screen, click **Next**. Installation proceeds automatically.

8. When installation is complete, click **Finish**.

9. When you see the license agreement, click **Agree**, then continue with the instructions in the next section to finish the installation.
Installing Additional Software for Windows 2000

After you accept the license agreement, you see the Options Menu:

1. Click **Install Optional Software**. You see the Optional Software menu:
   
   2. Click the button for each program to learn more about it.

   If you want the program, click **Install** and follow the instructions on the screen. Then click **Back** to return to the menu.

3. If you see a message about installing QuickTime, click **Yes** and follow the on-screen instructions. You don’t need a registration number.

4. When you’re finished installing software, close any open windows and click **Back** to return to the Options Menu.

5. Click **View Software Offers**. Click the button for each offer to learn more about it, then follow the instructions on the screen. When you’re finished, click **Back**.

   If you see a message asking you to restart your computer, select **No** and click **Finish**. It’s better to restart after you have finished installing software.

6. When you’re finished, close any open windows and click **Back** to return to the Options Menu.

7. Click **Install Printer Information Center**, then follow the on-screen instructions.

8. At the Options Menu, click **Exit**.
9. When you see the registration screen, register your printer with EPSON as instructed. Remove the CD-ROM and keep it in case you need to reinstall any software later.

10. Restart your computer if prompted. You’re ready to print.
Solving Problems

See “Diagnosing Printer Problems” on page 75 to help determine what the cause of your printer problem may be. Then see these sections for solutions:

- “Setup and Software Installation Problems” on page 77
- “Printer Problems” on page 78
- “Quality Problems” on page 79
- “Paper Problems” on page 81
- “CD/DVD Printing Problems” on page 82
- “Miscellaneous Problems” on page 82
- “Uninstalling and Reinstalling Printer Software” on page 83
- “Where To Get Help” on page 84

**Tip:** It’s a good idea to check EPSON’s support web site periodically for free updates to your printer driver. Visit http://support.epson.com. Download instructions are posted for your convenience.
Printer Parts

- Paper support
- Sheet feeder
- Edge guide
- Output tray and extensions
- Paper stoppers
- Inlet button
- Paper button
- Power button
- Adjust lever
- Front sheet feeder slot
- Auto cutter connector
- Photo basket mounting hole
- Roll paper button
- Ink button
- Roll paper feeder
- Roll paper edge guide
- Roll paper holders
- Parallel port
- USB port

(Automatic roll paper cutter and basket not pictured)
# Diagnosing Printer Problems

First, check the printer’s lights (see below) or run a printer check (see page 76).

<table>
<thead>
<tr>
<th>Lights</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green ✗ power light flashes</td>
<td>The printer is receiving a print job, replacing an ink cartridge, charging ink, or cleaning the print head.</td>
</tr>
<tr>
<td>Green ✗ power light flashes and red □ paper light is on</td>
<td>Your paper ran out. Load more paper and press the □ paper button.</td>
</tr>
<tr>
<td>Green ✗ power light is on and red □ paper light flashes</td>
<td>Paper is jammed in the printer. Press the □ paper button to eject the jammed paper. If the light is still flashing, open the cover and remove all paper, including any jammed or torn pieces. Then reload paper and press the □ paper button to continue printing. You can also set the adjust lever to the ！ position, pull the jammed paper out, then return the lever to the ！ position. If you’re using roll paper, press the □ paper button. If the paper is jammed, remove it, then reload it to continue printing.</td>
</tr>
<tr>
<td>Red ！ ink light flashes</td>
<td>One of the cartridges is low on ink. Check the message that appears on your screen to determine which cartridge is low. Or follow the instructions on page 60 to check your ink supply. Make sure you have a replacement cartridge.</td>
</tr>
<tr>
<td>Red ！ ink light is on</td>
<td>One of the cartridges is out of ink. Make sure you have a new cartridge, then follow the steps on page 61 to install it. If you have just installed a new cartridge, it may be incompatible with the printer or incorrectly installed. Reinstall it or replace it with the correct cartridge; see page 60.</td>
</tr>
<tr>
<td>Red □ paper light and red ！ ink light are on</td>
<td>Paper may be blocking movement of the print head. Turn off the printer, then open the cover and remove any jammed paper or other foreign objects. Turn the printer back on again. If the lights are still on, contact your dealer or EPSON; see page 84.</td>
</tr>
<tr>
<td>Green ✗ power light, red □ paper light, and red ！ ink light all flash</td>
<td>The printer may have an internal error. Turn off the printer, wait a few seconds, and turn it on again. If the lights are still flashing, contact your dealer or EPSON; see page 84.</td>
</tr>
<tr>
<td>Green ✗ power light and red □ paper light flash</td>
<td>The cutter is jammed or is unable to cut. Remove EPSON paper and try reloading it; non-EPSON paper may be too thick.</td>
</tr>
<tr>
<td>Red □ paper light flashes and red ！ ink light is on</td>
<td>The cutter can’t operate. Turn the printer off and remove the cutter, then contact your dealer or EPSON; see page 84.</td>
</tr>
</tbody>
</table>
Running a Printer Check

You can run a printer check to determine whether a problem comes from the printer or some other source.

1. Turn off your printer and computer.
2. Disconnect the printer’s interface cable.
3. Load letter-size paper in the printer.
4. Hold down the paper button, then press and release the power button. When printing starts, release the paper button.

A test page prints showing the printer’s ROM version number, an ink counter code, and a nozzle check pattern. (If the pattern has gaps, you need to clean the print head; see page 57.)

- If the test page prints, the problem probably lies in your software settings, interface cable, or computer, or your software may not be installed correctly.
- If the test page doesn’t print, you may have a problem with your printer.

Try the suggestions in “Problems and Solutions” beginning on page 77. If nothing works, contact your dealer or EPSON as described on page 84.

5. Turn off the printer, reconnect the interface cable, then turn on your printer and computer.
Problems and Solutions

Setup and Software Installation Problems

The printer makes noise after ink cartridge installation.

- When you install ink cartridges, the printer must charge its print head for a minute or so. Wait until it’s finished (the green light stops flashing) before you turn off the printer, or it may use excess ink the next time you turn it on.

- Make sure the ink cartridges are inserted completely and no packing material remains in the printer. Turn off the printer, wait a moment, then turn it on.

You’re having problems installing or using the printer software.

- Make sure your printer is turned on and its cable is securely connected at both ends. Follow the installation steps on the Start Here sheet or on page 67, and make sure your system meets the requirements; see page 87.

- Close other programs, including screen savers and virus protectors, and install again.

- If the SP 960 icon doesn’t appear in the Macintosh Chooser, you may have an extension conflict. Turn off any unnecessary extensions and restart.

- If you see an error message with Windows 2000, you may not have software installation privileges. Contact your System Administrator.

- If you’re using Windows and the USB port, make sure your system was not upgraded from Windows 95; the USB driver may not install correctly.

- Make sure the USB Controller is working properly in Device Manager. See your Windows help system for details.

- If you’re printing over a network, see your Reference Guide in the EPSON Printer Information Center for instructions on configuring your printer for use on a network.

- In Windows, make sure your printer is selected as the default printer.
Printer Problems

Only the green \(\bigcirc\) power light is on, but nothing prints.

- Make sure the interface cable is securely connected at both ends and meets the system requirements; see page 87.
- Run a printer check as described on page 76. If the test page prints, make sure your software is installed correctly.
- If you’re printing on a network, make sure you set up your printer for network printing, as described in your on-screen Reference Guide in the EPSON Printer Information Center.

The printer sounds as though it is printing, but nothing prints.

- The print head nozzles may need cleaning; see page 57 for instructions.
- The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface.

Your printer makes noise when you turn it on or after it has been sitting for awhile.

Your printer is performing routine maintenance.

Printing is too slow.

Make sure your system meets the requirements listed on page 87. If you’re printing a high-resolution image, you need more than the minimum requirements. You may also need to:

- Clear space on your hard drive or run a defragmentation utility.
- Close open programs that you’re not using.
- Increase your system’s memory (RAM).

For the fastest printing, try these tips:

- Select Draft as the Quality Type (Windows) or set the Quality/Speed slider to Speed (Macintosh).
- In the Advanced window, turn MicroWeave® off (Macintosh only) and/or turn High Speed on.
- If your printer is connected to a USB hub, disconnect any unused USB devices.
- If you’re using the parallel port, enable ECP/DMA mode on your computer’s parallel port. See your computer documentation or the manufacturer for instructions.
**Quality Problems**

You see banding (light lines).

- Clean the print head nozzles; see page 57 for instructions.
- Select a higher print quality and turn off **High Speed** mode; see page 13 (Windows) or page 28 (Macintosh).
- Make sure the Type or Media Type setting matches your paper; see pages 15 or 30 for guidelines.
- Make sure the printable side of the paper is face up.
- The ink cartridges may need replacing; see page 59.
- Align the print head as described on page 63.

Your print is blurry or smeared.

- Make sure your paper isn’t damp, curled, or loaded face down.
- Use a support sheet with special paper, or try loading your paper one sheet at a time.
- Make sure your paper meets the specifications listed in the on-screen **Reference Guide** in your EPSON Printer Information Center.
- Use EPSON papers for proper saturation and ink absorption.
- Check the adjust lever. Set it to ☑ for most papers and ☐ for envelopes; for heavy stock, see page 54.
- Align the print head as described on page 63.
- Remove each sheet after printing on glossy paper or transparencies. Wait several hours before handling.
Your printout is faint or has gaps.

- Clean the print head nozzles; see page 57 for instructions.
- The ink cartridges may be old or low on ink; see page 59.
- Make sure the Type or Media Type setting matches your paper. See pages 15 or 30.
- Make sure your paper isn’t damaged, old, dirty, or loaded face down. If it is, load new paper, face up. For best results, use genuine EPSON paper.

Your printout is grainy.

- Use a higher quality paper or select a higher Quality Type (Windows) or Print Quality setting (Macintosh).
- Align the print head as described on page 63.
- Increase the image resolution or print it in a smaller size; see your software documentation.

You see wrong or missing colors.

- Make sure Black Ink Only is off (Windows) or Color is selected (Macintosh), even for black and white photographs.
- Clean the print head nozzles; see page 57 for instructions.
- The ink cartridges may be old or low on ink; see page 59.
- Try turning off PhotoEnhance™. Also check if you’re using a special effect that alters image colors, like Sepia.
- Try changing the Gamma setting. See page 13 (Windows) or page 28 (Macintosh).
- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. Also see the on-screen Reference Guide in your EPSON Printer Information Center for color management information.

Your printouts have scratches or other marks.

Try loading the paper in the front sheet feeder, as described on page 54.
Paper Problems

Paper doesn’t eject fully or is wrinkled.

■ If the paper doesn’t eject fully, you may have set the wrong paper size. Press the paper button to eject the paper, then select the correct paper size.

■ If it’s wrinkled when it ejects, the paper may be damp or too thin. Load new paper.

Paper sheets don’t feed correctly or jam in the printer.

■ If paper doesn’t feed or multiple pages feed, remove it from the sheet feeder. Fan the edges of the sheets, reload them against the right side of the feeder, and slide the edge guide snugly, but not too tightly, against the paper. Don’t load paper above the arrow on the left edge guide.

■ If paper jams, press the paper button. If necessary, open the cover and remove any jammed or torn pieces. Load new paper and press the paper button.

You can also set the adjust lever to the position, pull out the jammed paper, and then return the lever to the position.

Heavy stock doesn’t feed correctly or jams in the printer.

Follow the steps on page 54 to use the front sheet feeder.

Roll paper doesn’t feed correctly or jams in the printer.

■ Cut the end of the paper straight across. If it’s cut diagonally, the paper won’t feed smoothly.

■ If the roll paper end is curled, place the end inside a folded sheet of paper and roll it backwards against the curl.

■ Make sure the paper is loaded in the roll paper feeder, not the sheet feeder; see page 35.

■ As you load the paper, gently hold it in the roll paper feeder with your hand; don’t force the paper into the feeder.

■ Select Roll or Roll Paper as the Paper Source in your print settings. Otherwise, too much paper will feed.

■ If extra paper feeds, press the roll paper button for three seconds to rewind the paper (repeat if necessary to back it all the way out). If the paper light is on, press the paper button to turn it off. Reload the paper as described on page 35.
**CD/DVD Printing Problems**

Images and text are not centered on the CD/DVD.
Adjust the print position as described on page 51.

Ink smears on the CD/DVD or printing is too light.
Adjust the print density as described on page 53. You can also adjust brightness or contrast, as described on page 45.

Printed CDs or DVDs are dirty.
Clean the roller as described on page 43.

**Miscellaneous Problems**

The printer prints blank pages.
- Make sure your printer is selected in the Print window, or is the active printer in the Macintosh Chooser or Print Center.
- Clean the print head nozzles; see page 57 for instructions.

You see incorrect characters.
- Make sure the interface cable is securely connected at both ends and meets the system requirements on page 87.
- Make sure your printer is selected in the Print window, or is the active printer in the Macintosh Chooser or Print Center.
- If you’re using a switch box or USB hub with your printer, connect the printer directly to your computer instead.

The margins are incorrect.
- Make sure the paper settings are correct for your paper size.
- Place your paper against the right side of the feeder with the edge guide snug against it.
- Make sure the Borderless option is set correctly for your margins; see page 40 for roll paper or pages 18 or 32 for cut sheets.

Image size/position is incorrect.
- Make sure the paper and layout options are set correctly.
- Always load paper short-edge first, even for landscape-oriented images.
Uninstalling and Reinstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities if, for example, you upgrade your Windows operating system. You don’t need to uninstall your other photo software or the EPSON Printer Information Center.

**Windows**

1. Click **Start**, and select **Programs** or **All Programs**.
2. Point to **Epson** or **EPSON Printers**, then select **EPSON Printer Software Uninstall**.
3. In the next window, select **EPSON Stylus Photo 960** and click **OK**. Then follow the on-screen instructions.
4. Restart your computer, then see the **Start Here** sheet or page 67 to reinstall software.

   **Note:** If you uninstall the EPSON Printer Software or P.I.M. II Plug-In, the ICC color profiles will also be uninstalled. You will have to reinstall the profiles from the CD-ROM.

**Macintosh OS 8.6 to 9.x**

1. Insert your printer software CD-ROM.
2. Double-click **EPSON** on your desktop, then double-click **EPSON** in the folder that opens. The Install Menu appears.
3. Click **Install Printer Driver**, then click **Continue**. On the Installer screen, click the arrow in the Easy Install list at the top and select **Uninstall**. Then click the **Uninstall** button at the bottom and follow the instructions.
4. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

**Macintosh OS X**

1. Open the Applications folder, then the Utilities folder.
2. Select Print Center, select SP 960, and click the Delete button.
3. Restart your Macintosh, then see the Start Here sheet to reinstall your software.

---

**Where To Get Help**

If you need help with your printer, EPSON Print CD, Film Factory, or the P.I.M. II Plug-in for Adobe Photoshop, see the information below. See page 85 for help with the other software that came on your printer CD-ROM.

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call (800) 922-8911. Your EPSON SoundAdvice™ Express Code is <strong>70415</strong>. Use this code to quickly select the EPSON Stylus Photo 960 in SoundAdvice.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial:

- U.S.: (562) 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.
- Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.
Please have the following information ready:

■ Product name (EPSON Stylus Photo 960)
■ Product serial number (located on the back of the printer and on its box)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration and operating system version
■ Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Technical Support for Other Photo Software**

For help with the photo software on your CD-ROM, contact these companies:

<table>
<thead>
<tr>
<th>Software</th>
<th>Web site or e-mail</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monaco Systems</td>
<td><a href="http://monacosys.support.html">http://monacosys.support.html</a></td>
<td>(978) 749-9944, extension 2204 or 2213</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:support@monacosys.com">support@monacosys.com</a></td>
<td>8:30 AM to 6 PM, Eastern Standard Time, Monday to Friday</td>
</tr>
<tr>
<td>Applied Science Fiction Digital ROC or Digital SHO</td>
<td><a href="http://asf.com/support">http://asf.com/support</a></td>
<td>—</td>
</tr>
</tbody>
</table>
Requirements and Notices

Windows System Requirements

To use your printer and its software, we recommend that your system has:

- Microsoft Windows compatible PC with a Pentium® II 266 MHz (Windows 98 or Me) or 350 MHz (Windows 2000 or XP) or better processor (Pentium III 500 MHz recommended)
- 128MB or more of RAM recommended
- 200MB or more of free hard disk space recommended
- VGA or better display adapter and monitor
- CD-ROM or DVD drive for installing the printer software
- USB connection: a Windows-compliant USB port and a shielded USB “AB” cable, up to 6.5 feet (2 meters) long
  Parallel connection: a high-speed, bidirectional, IEEE-1284 compliant parallel cable (6 to 10 feet long) with a D-SUB, 25-pin, male connector (computer end) and a 36-pin Centronics® compatible connector (printer end)

Macintosh System Requirements

To use your printer and its software, we recommend that your system has:

- An Apple® iMac™ series, Power Macintosh® G3 or G4, PowerBook® or iBook™
- Mac OS 8.6, 9.x, or OS X 10.1 or later (Mac OS 9.0 or later recommended)
- 128MB or more of available RAM recommended
- 200MB or more of free hard disk space recommended
- VGA display or better
- CD-ROM or DVD drive for installing the printer software
- A shielded USB “AB” cable, up to 6.5 feet (2 meters) long
Important Safety Instructions

Before using your printer, read these safety instructions to make sure you use it safely and effectively:

- Be sure to follow all warnings and instructions marked on the printer.
- Use only the type of power source indicated on the printer’s label.
- Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
- Place the printer near a wall outlet where the plug can be easily unplugged. *Placez l’imprimante près d’une prise de courant où la fiche peut être débranchée facilement.*
- Do not let the power cord become damaged or frayed.
- If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the outlet’s ampere rating.
- Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
- Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
- Leave enough room around the printer for sufficient ventilation, leaving at least 3.9 inches between the back of the printer and the wall.
- Do not place the printer near a radiator or heating vent or in direct sunlight.
- Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
- When transporting or storing the printer, don’t tilt it, stand it on its side, or turn it upside-down. This may allow ink to leak from the ink cartridges.
- Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.

**Caution:** Always turn the printer off using the power button. Don’t switch off the power strip or unplug the printer until the green power light is off.

- Do not block or cover the openings in the printer’s case or insert objects through the slots.
- Except as specifically explained in this manual, do not attempt to service the printer yourself.
- Unplug the printer and refer servicing to qualified service personnel under the following conditions:
  - If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not put your hand inside the printer or touch a cartridge during printing.
- Do not move the print head by hand. You may damage the printer.
- Install the ink cartridge immediately after you remove it from its package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of first installing them.
- Store ink cartridges in a cool, dark place.
- Store ink cartridges with the bottom of the packaging facing down.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not shake an ink cartridge after removing it from its package; this can cause leakage.
- Do not remove or tear the label on an ink cartridge; this can cause leakage.
- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
- Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are removed. Tape the ink cartridge holder to the printer case to make sure it remains in the proper position.

**Automatic Roll Paper Cutter Safety Instructions**

- Turn off the printer before attaching or removing the automatic roll paper cutter.
- Keep the cutter out of the reach of children.
- Do not touch the area where the paper ejects.
- Do not disassemble or modify the cutter.
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Ink Jet Printer
Model: B131A

ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.
Epson America, Inc. Limited Warranty

What Is Covered: Epson America, Inc. ("EPSON") warrants to the first retail purchaser that the EPSON printer covered by this limited warranty statement, if purchased and used in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. EPSON also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer’s specified usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. For warranty service, you must provide proof of the date of original purchase.

What EPSON Will Do To Correct Problems: Should your EPSON printer prove defective during the warranty period, please call the EPSON Connection at (562) 276-7282 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An EPSON service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, EPSON will, at its option, exchange or repair the printer without charge for parts or labor. If EPSON authorizes an exchange for the defective unit, EPSON will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to EPSON within five (5) working days of receipt of the replacement. EPSON requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, EPSON will direct you to send your printer to EPSON or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the EPSON authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes EPSON property. The replacement printer or part may be new or refurbished to the EPSON standard of quality, and, at EPSON’s option, may be another model of like kind and quality. EPSON’s liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. This warranty is not transferable and will not apply to products purchased from an end user. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by EPSON. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON product after its shipment from EPSON, e.g., dealer or user-added boards or components. EPSON is not responsible for warranty service should the EPSON label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-EPSON products, or service other than by an EPSON Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR
FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE
EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS
AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED
ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE
BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL
BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT,
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE
OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH
OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some
jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the
above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and
you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc. ■ P. O. Box 93012 ■ Long Beach, CA 90809-3012
Index

A
Accessories, ordering, 85
Adjust lever, 8 to 9, 20 to 21, 47 to 56
Adobe Photoshop
   P.I.M. plug-in for, 3
Advanced settings, 13 to 14, 28 to 29
Aligning print head, 63 to 65
Animations, Print Show, 4 to 5
Automatic mode
   Macintosh OS 9.x, 22 to 23
   Macintosh OS X, 26
Automatic roll paper cutter, see Cutter

B
Background printing, 23 to 24, 27
Banding, 79
Basic printing
   Macintosh OS 9.x, 22 to 24
   Macintosh OS X, 25 to 27
   Windows, 10 to 12
Basket
   installing, 36 to 37, 39
   removing, 42
Blank pages, 82
Blurry images, 79
Borderless printing, 16 to 18, 31 to 32
Bright White Paper, 15, 30
Browser, 5
Buttons, 74 to 75

C
Cable, printer, 87
Cancelling printing
   Macintosh OS 9.x, 24
   Macintosh OS X, 27
   Windows, 12
Card stock, printing on, 54 to 56
CDs
   adjusting print density, 53 to 54
   adjusting print position, 51 to 53
   designing, 43 to 46
   inserting in printer, 47 to 50
   ordering, 43
   printing on, 43 to 54
   printing problems, 82
Characters, incorrect, 82
Checking printer, 76
Chooser, Macintosh, 77, 82
Cleaning
   print head, 57 to 59
   printer, 65
   roller, 43
Color management
   menu, Macintosh OS X, 27
   settings, 13, 29
Color problems, 80
ColorLife Photo Paper, 15, 30
ColorSync, 27
Control panel, 74 to 75
Controlling printing
   Macintosh OS 9.x, 24
   Macintosh OS X, 27
   Windows, 12
Custom settings
   Macintosh, 28 to 29
   Windows, 13 to 14
Cutter
   adjusting cutting position, 38
   installing, 36, 39
   removing, 42
   safety instructions, 89
   selecting settings for, 39, 40
D
Declaration of Conformity, 91
Default settings, Windows, 12
Documentation, 4 to 6
Double-Sided Matte Paper, 15, 30
DVDs, see CDs

E
ECP/DMA mode, 78
Electronic manual, 5 to 6
Energy Star compliance, 91
Envelopes, 9, 21
EPSON
accessories, 85
Film Factory, 3
help, 84 to 85
Monitor3, 24
papers, 15, 30
PhotoCenter, 4
Print CD, 43 to 46, 50 to 54
Printer Information Center, 5 to 6
SoundAdvice, 84
Store, 17, 32, 61
warranty, 92 to 93

F
Faint images, 80
FCC Compliance Statement, 90
Features, 1
Film Factory, 3
Format for setting, Macintosh OS X, 25
Front sheet feeder, 47 to 56, 81

G
Gamma setting, 29, 80
Glossy Photo Paper, 15 to 16, 30 to 31
Grainy prints, 80
Greeting Cards, Glossy Photo, 15, 30

H
Head Cleaning utility, 57 to 59
Heavy stock, printing on, 54 to 56
Help
EPSON, 84 to 85
see also Printer Information Center and Troubleshooting
High Speed setting, 78 to 79

I
ICM (Image Color Matching) setting, 80
Incorrect
characters, 82
colors, 80
margins, 82
Ink cartridge
level of ink in, 12, 23, 60
ordering, 60 to 61
problems, solving, 75, 77
replacing, 59 to 62
safety instructions, 61, 89
Ink Jet Transparencies, 15, 30
Ink level, checking
Macintosh, 23, 60
Windows, 12, 60
Ink setting
envelopes, 21
Macintosh OS 9.x, 23
Macintosh OS X, 26
problems, solving, 80
Installation problems, 77
Installing software, 67 to 71, 77
Iron-On Transfer Paper, 15, 30

J
Jams, paper, 81

L
Layout problems, 82
Layout settings
Macintosh OS 9.x, 23
Macintosh OS X, 27
Windows, 14
Letterhead, 8, 20
Lever, adjust, 8 to 9, 20 to 21, 47 to 56
Lights, 74 to 75
Luster Photo Paper, 15, 30, 33 to 41
M
Macintosh
  basic printing, OS 9.x, 22 to 24
  basic printing, OS X, 25 to 27
  Chooser, 77, 82
  system requirements, 87
  uninstalling software, 83 to 84
Maintaining printer, 57 to 66
Manual feed slot, 47 to 56, 81
Margins, incorrect, 82
Matte board, printing on, 54 to 56
Matte Paper Heavyweight, 15, 30
Matte Paper, Double-Sided, 15, 30
Media Type setting
  envelopes, 21
  Macintosh OS 9.x, 23
  Macintosh OS X, 26
  selecting correct, 30
  Windows, see Paper Type setting
MicroWeave setting, 78
Monitor3, 24
Monitoring ink level
  Macintosh, 23, 60
  Windows, 12, 60
Moving printer, 66

N
Network printing, 77
Noise, printer, 78
Nozzle Check, 58 to 59

O
Orientation setting
  envelopes, 9, 21
  Macintosh OS 9.x, 22
  Macintosh OS X, 25

P
P.I.M., see PRINT Image Matching
Page Layout settings, 14
Page Setup, Macintosh, 22, 25

Paper
  EPSON, 15, 30
  feeding problems, 81
  heavy stock, 54 to 56
  loading in front sheet feeder, 54 to 56
  loading in sheet feeder, 8, 17, 20, 32
  roll, see Roll paper
  thick, 54 to 56
Paper Size setting
  envelopes, 9, 21
  Macintosh OS 9.x, 22
  Macintosh OS X, 25
  roll paper, 40
  Windows, 11
Paper Source setting
  CDs and DVDs, 50
  heavy stock, 56
  Macintosh OS 9.x, 22
  Macintosh OS X, 25
  roll paper, 39, 40
  Windows, 11
Paper Type setting
  envelopes, 9
  Macintosh, see Media Type setting
  selecting correct, 15
  selecting in Windows, 11
Parallel cable, 87
Parallel port, 78
Photo Quality Glossy Paper, 15, 30
Photo Quality Ink Jet Paper and Cards, 15, 30, 63
Photo software, 3 to 4
Photo Stickers, 15, 30
PhotoCenter, EPSON, 4
PhotoEnhance, 80
Photographs, displaying and storing, 16, 31
Premium Bright White Paper, 15, 30
Premium Glossy Photo Paper, 15 to 16, 30 to 31, 33 to 41
Premium Luster Photo Paper, 15, 30, 33 to 41
Premium Semigloss Photo Paper, 15, 30, 33 to 41
Preprinted paper, 8, 20
Previewing printout, 23
Print CD software, 43 to 46, 50 to 54
Print Center, Macintosh OS X, 27
Print head
aligning, 63 to 65
cleaning, 57 to 59
Print Head Alignment utility, 63 to 65
PRINT Image Matching
description, 2 to 3
plug-in for Photoshop, 3
Print position check disk, 51 to 52
Print Quality
problems, 79 to 80
settings, 29
Print Settings menu, Macintosh OS X, 26
Print Show animations, 4 to 5
Print window, 10
Printer
cable, 87
clean, 76
cleaning, 65
control panel, 74 to 75
maintaining, 57 to 66
noise, 78
parts, 74
problems, 75 to 82
transporting, 66
Printer and Option Information utility, 38
Printer Information Center, 5 to 6
Printing
advanced, 13 to 14, 28 to 29
CDs and DVDs, 43 to 54
controlling, 12, 24, 27
Macintosh OS 9.x, basic, 22 to 24
Macintosh OS X, basic, 25 to 27
Windows, basic, 10 to 12
with custom settings, Macintosh, 28 to 29
with custom settings, Windows, 13 to 14
Problems
CD/DVD printing, 82
diagnosing, 75 to 76
installing software, 77
miscellaneous, 82
paper feeding, 81
print quality, 79 to 80
solving, 73 to 85
Progress Meter, 12
Properties window, 11

Q
Quality Type setting, 11
Quality/Speed setting
Macintosh OS 9.x, 23
Macintosh OS X, 26
roll paper, 41

R
Reference Guide, 5 to 6
Reinstalling software, 83 to 84
Roll paper
basket, see Basket
button, 36, 41
controlling printing, 41
cutter, see Cutter
holder, 34 to 36, 42
loading, 34 to 36, 39
printing on, 39 to 42
problems, solving, 81
removing, 41 to 42
storing, 42

S
Safety instructions, 88 to 89
Self adhesive sheets, 15, 30
Semigloss Photo Paper, 15, 30, 33 to 41
Service, 84 to 85
Sheet feeder
loading envelopes in, 9, 21
loading paper in, 8, 17, 20, 32
problems, solving, 75, 81
Slow printing, 78
Smeared printout, 8, 20, 79
Software
installation problems, solving, 77
installing, 67 to 72
photo, 3 to 4
Print CD, 43 to 46, 50 to 54
reinstalling, 83 to 84
uninstalling, 83 to 84
SoundAdvice, 84
Stickers, 15, 30
Support, 84 to 85
System requirements, 87
Technical support, 84 to 85
Testing printer, 76
Thick paper, 54 to 56, 81
Transfer paper, 15, 30
Transparencies, 15, 30
Transporting printer, 66
Troubleshooting, 73 to 85
Tutorials, Print Show, 4 to 5
Type setting, 11

Uninstalling software, 83 to 84
USB, 77, 82, 87
Utilities
   Auto Cutter Adjustment, 38
   Head Cleaning, 57 to 59
   Nozzle Check, 58 to 59
   Print Head Alignment, 63 to 65
   Printer and Option Information, 38

Warranty, 92 to 93
Watermark, 14, 23
Windows
   basic printing, 10 to 12
   default settings, 12
   installing software, 67 to 71
   system requirements, 87
   uninstalling software, 83